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Overview 
Continuous process performance improvement is a hallmark for the sustainable success of any 
organization, but it is both challenging and expensive without access to real information that is delivered 
in a format that easily enables analysis. Fiori KPIs are an increasingly popular choice for visualizing 
performance benchmarks. 

The Process Analytics solution is tightly integrated with Process Director Accounts Payable (formerly 
known as the INVOICE COCKPIT Suite) and comes complete with sample KPIs. 

SAP Fiori® is a platform that provides the porting of applications on mobile devices. It is based on SAP's 
technology platform, NetWeaver. SAP Fiori® enables applications to be used on desktop computers, 
tablets, and smartphones, and supports HTML5. 

You can configure the Kofax Process Director for use with SAP Fiori® add-ons to suit the requirements of 
your organization. 

For more information on configuring Process Director and Process Director Accounts Payable, see the 
following guides. 

• Process Director Import and Upgrade Guide 

• Process Director Accounts Payable Configuration Guide 

• Process Director Configuration Guide 

• Work Cycle Configuration Guide 

• Process Director Web Application Configuration Guide 

Prerequisites 

To import the Process Director for use with SAP Fiori® add-ons into SAP, the following prerequisites 
must be met. 

• UIX01CA1 100 0005 SAPK-10005INUIX01CA1 UI for Cross-Applications 

• UIX01EAP 100 0007 SAPK-10007INUIX01EAP UI for ERP Central Applications 

• UIX02EA4 100 0002 SAPK-10002INUIX02EA4 UI component for ERP Applications 1.0 

• UIX02EAP 100 0004 SAPK-10004INUIX02EAP UI for ERP Central Applications 1.0 

• FIORI ERP APPLICATIONS X2 1.0 04 (04/2015) sap.com FIORI ERP APPLICATIONS X2 1.0 

• Kofax Process Director 7.5 or higher 

• Kofax Process Director 7.5 or higher 

 

Note: The Process Director for use with SAP Fiori® add-ons have been developed based on SAPUI5 
1.38.18 and tested on 1.38.19 and 1.44.12. 

The add-ons have been tested with Process Director 7.5 and Process Director Accounts Payable 7.5, but 
potentially run with older versions too. 
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 Process Director for use with SAP Fiori® transports 

The Process Director for use with SAP Fiori® add-ons have two transports. 

• Front End (FE): Imported into the gateway 

• Back End (BE): Imported into the ERP system 

Location 

The Process Director for use with SAP Fiori® add-on transports are available on request. Partners and 
customers should contact their local Kofax representative to place an order. 

Importing the transport 

See the Process Director Import and Upgrade Guide for information on how to import a transport into 
SAP. 

Checking the namespaces  

The Kofax_ReadSoft_Namespaces_FQAK901961.zip transport creates the /EBY/, /COCKPIT/, and 
/RSE/ namespaces. It is recommended that you check the settings of the /EBY/ and /COCKPIT/ 
namespaces. To check their settings, complete the following steps. 

1. Start the SE03 SAP transaction.  

2. In the Administration folder, double-click Display/Change Namespaces, and then click the 
Execute button. 

3. The namespaces should be defined as follows: 

Namespace /COCKPIT/ 

Namespace role C – Recipient  

Correction license 13375972671823267744  

Short text Process Director - ReadSoft AG - Germany, Frankfurt/M  

Owner ReadSoft AG 

Note: The /COCKPIT/ namespace is required only for Accounts Payable. 

Namespace /EBY/ 

Namespace role C – Recipient  

Correction license 05790374410114137903 

Short text Process Director - ReadSoft AG - Germany, Frankfurt/M  

Owner ReadSoft AG 
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4. In the Administration folder, double-click Set System Change Option, and then click the Execute 
button. 

5. The namespaces should be defined as follows: 

Namespace/Name 
Range 

Process Director - ReadSoft AG - Germany, Frankfurt/M 

Prefix /COCKPIT/ 

Modifiable X - Modifiable 

 
 

Namespace/Name 
Range 

Process Director - ReadSoft AG - Germany, Frankfurt/M 

Prefix /EBY/  

Modifiable X - Modifiable 
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Configuration 

SAP Launchpad designer 

Start the Launchpad designer 

Start the launchpad designer by using the following URLs: 

https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html 

https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html ?sap-client=<client>&scope = 
<CONF/CUST> 

Launchpad tiles are created in catalogs. Catalogs are collections of tiles that have similar technical or 
business functionality (similar to the development packages in ABAP). 

You can add tiles to groups. Groups are collections of tiles for specific end users and can contain tiles 
from different catalogs. 

You can grant independent access to catalogs and groups. 

Create a catalog 

To create a new catalog, complete the following steps. 

1. In the standard launchpad configuration, under the Catalogs section, in the footer, click the  button 
to display the Create Catalog dialog box. 

2. Enter a title and ID for the new catalog and click Save. 

The new catalog is created. 

Note: The title and ID should follow the customer-specific naming convention. 

Example: zcustomer_cat1 

3. Next, select the Target Mapping icon, and in the footer, click Create Target Mapping to display a 
new form. 

 

4. Enter the required information. The following list provides some examples. 

Semantic Object: Fiori Application 

Action: <TO DO > 

Title: Process Director AP 

URL: /sap/bc/ui5_ui5/eby/ <TO DO > 

• ID: eby.frap_wc 

5. Click Save. 
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Tiles 

Tiles can be static or dynamic. In dynamic tiles, the data is updated from the database in near real-time 
(in relatively small intervals). 

Note: It is recommended to use dynamic tiles so that even before entering the application, you have an 
overview of the number of documents that need to be processed.  

Create a dynamic tile 

To create a dynamic tile, complete the following steps. 

1. In the standard launchpad configuration, select the Tiles icon and in the footer, click Create Tile. 

 

2. On the next screen, select App Launcher – Dynamic. 

 

3. In the General section, enter the required information. The following list provides some examples. 

• Title: Process Director AP 

• Subtitle: Fiori App 

• Keywords: [Optional] 

• Icon: Select an icon. (e.g. sap-icon://Fiori2/F0102) 

• Information: [Optional] 

• Number Unit: Documents 

4. In the Dynamic Data section, enter the required information. The following list provides some 
examples. 

• To procure the number of invoices, use the following Service URL: 

/sap/opu/odata/EBY/FRAP_WC/HeaderSet/$count 

• Refresh Interval in Seconds: 30 

This is the number of seconds after which the dynamic content is read again from the data 
source, and the display is refreshed. 

Note: The launchpad uses a default of 10 seconds, unless you enter a higher value in this field. If 
the value entered is >0 and <10, it will fall back to 10 seconds. If the value entered is 0, the 
dynamic tile is updated only once (on loading). If the value is >= 10, this value is taken as the 
refresh interval. 
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Too small an interval will result in the database being read too often, while a large interval will 
make the dynamic tile similar to a static one. 

5. In the Navigation section, enter the required information. The following list provides some examples. 

• Use semantic object navigation: Select the check box to use this option. 

• Semantic Object: Fiori Application 

• Action: eby_frap_wc 

• Note: This is a standard launchpad configuration option.  

• Parameters: [Optional] 

• The entries in the Tile Actions section are optional and not required to be filled in. 

6. Click Save. 

Create a group and add an existing tile to it 

To create a new group, complete the following steps. 

1. In the standard launchpad configuration, under the Groups section, in the footer, click the  button 
to display the Create Group dialog box. 

2. Enter a title and ID for the new group and click Save. 

The new group is created. 

Note: The title and ID should follow the customer-specific naming convention. 

Example: zcustomer_grp1 

3. Next, in the Show as Tiles section, click the  icon to select the catalog that you created. 

The selected catalog displays the dynamic tile that you created. 

4. Click the plus icon below the title to add that tile to the group. 

 

The plus icon changes into a tick  and the tile is successfully added to the group. 

Authorizations and roles 

For transactional applications, ABAP backend users with corresponding roles and authorizations are 
necessary. The roles provide authorizations for the OData service of the apps. The roles for the 
transactional applications do not comprise any authorization for the business data that needs to be 
displayed in the application. It is assumed that these authorizations will be provided by the customer. 

For every role, authorizations need to be granted according to the customer’s roles and authorization 
concept.  
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To assign the Process Director for use with SAP Fiori® application to users, complete the following steps. 

1. Go to the PFCG transaction. 

2. Create a new role or select an existing one. 

3. Click Single Role to create one role. 

4. Enter a description for the role and click the Save button. 

5. Switch to the Menu tab.  

6. In the Hierarchy section, select the Role Menu folder and then from Transaction, select SAP Fiori 
Tile Catalog. 

7. In the Assign Tile Catalog dialog box, select or enter a catalog ID and click the Continue  button. 

8. The catalog ID that was created earlier has to be assigned to the authorization role. 

9. In the Hierarchy section, select the Role Menu folder again and then from SAP Fiori Tile Catalog, 
select SAP Fiori Tile Group. 

10. In the Assign Group dialog box, select or enter a group ID and click the Continue  button. 

11. The group ID that was created earlier has to be assigned to the authorization role. 

12. Click the Save button. 

13. Switch to the User tab. 

14. Enter the required user IDs and click the Save button to add the role to the desired users. 

The authorized users can now access the required application. 

Assign the Web Service to user roles 

Depending on the existing authorization concepts, the Web Service may need to be added to the user 
roles. To assign the Web Service to a role, complete the following steps. 

1. Go to the PFCG transaction. 

2. Select the role that you need to modify. 

3. Switch to the Authorizations tab. 

4. Click the Change Authorization Data button. 

5. From the Object class AABB drop-down list, select the S_SERVICE authorization object. 

6. Click the edit icon next to the SRV_NAME node. 

7. From the Type drop-down list, select TADIR Service. 

8. From the Object Type drop-down list, select IWSG. 

9. From the Object Name drop-down list, select /EBY/FRAP_WC_0001. 

10. Save the changes. 
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About this guide 
This guide explains how to install and configure Process Analytics. It assumes that you are already 
familiar with SAP NetWeaver Business Warehouse and Process Director Accounts Payable (PD AP). 

Please note that this guide is available only in English. 

For more information about Process Director Accounts Payable, see the following guides: 

• PROCESS DIRECTOR Accounts Payable Configuration Guide 

• PROCESS DIRECTOR Accounts Payable User Guide 

• PROCESS DIRECTOR Configuration Guide 

• PROCESS DIRECTOR User Guide 

This guide contains the following main chapters: 

• About Process Analytics  

Provides an overview of Process Analytics, as well as information about the data extraction and 
aggregation processes. 

• Install Process Analytics in SAP ERP/ECC 

Explains how to install Process Analytics in SAP ERP/ECC. It also lists the system requirements. 

• Configure Process Analytics 

Describes the general configuration of the Process Analytics. 
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About Process Analytics 
Process Analytics is a (near) real-time reporting solution for SAP ERP comprised of three components: 

• The Evaluation Engine, abbreviated as EvE. This is the backend running in ERP, comprising 
maintenance, configuration and data processing modules. 

• The Evaluation Engine reporting frontend. This is a web frontend with an overview dashboard and 
graphical capabilities for detailed reporting. For reporting users, the reporting frontend based on SAP 
UI5 is synonymous with Process Analytics.  

• The Evaluation Engine configuration frontend. This is a web frontend that allows the creation and 
extension of KPIs and data flows for EvE. 

Business goals 

For the business user, Process Analytics is a graphical reporting frontend for SAP ERP. It is lightweight 
and easy to adopt. All relevant KPIs and evaluation results are shown on a dashboard overview, with the 
ability to drill deeper into the data. To keep the overall footprint of the application small, the drilldown 
capabilities are limited. Instead, the user has the option to jump directly to the focused data in the 
operational system. 

The aggregated data for the reporting frontend is calculated by data flows which run automatically in the 
connected source systems. Modification and creation of data flows are done in a separate graphical 
frontend. Monitoring tools for the data flows ensure frictionless operation of the reporting framework. 

Data flow concept 

Data flows are customizable sets of classes that transform operational data into reporting-ready 
aggregates.  A data flow can have multiple entry points that input operational data into the process. 
These entry points are called sources. The exit points represent the consumable reporting data, namely 
KPIs, aggregates and evaluations. A data flow can have many of these exit points. Intermediary nodes in 
a flow are filters and supplements. Filters remove data records, while supplements add data fields. 
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Install Process Analytics in SAP ERP/ECC 

Import the workbench transport  

Process Analytics: 

Kofax_Process_Analytics_BE_1_4_FQAK902410       Kofax Process Analytics BE 1.4.0 

Kofax_Process_Analytics_FE_1_4_FQAK902413      Kofax Process Analytics FE 1.4.0 

Initial configuration in SAP 

To activate Process Analytics on a single SAP backend system, complete the following steps. 

1. Go to transaction /EBY/EVE_CONFIG and click Lock & Edit . 

2. Select Configure as central backend system. 

 

3.  Enter a system description.  

4. Select Allow use of shared memory. 

5. Click Activate Configuration .   

6. In the popup that opens, click the Activate button to confirm that all data will be deleted. 

Activate the namespace /B507  

1. Go to transaction SE03. 

2. In the Administration group, double-click Display/Change Namespaces. 

3. Add a new entry with the following values. 
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Namespace /B507/ 

Namespace role C 

Repair License 23178636483082621615 

Short text BW generation namespace for /EBY/ 

Owner Kofax 

4. In transaction SE03, in the Administration group, double-click Set System Change Option. 

5. Under Namespace/Name Range, set  /B507/ to Modifiable. 

Activate the Gateway Service  

1. Go to transaction SICF. 

2. Click Execute  and activate the following services. To activate a service, navigate to the service 
and right-click it, then select Activate Service. 

/default_host/sap/bc/apc/eby/bi_pfa_config_notify 

/default_host/sap/bc/apc/eby/bi_pfa_update_notify 

/default_host/sap/bc/bsp/eby/bi_eve_config 

/default_host/sap/bc/bsp/eby/bi_fiori 

/default_host/sap/bc/bsp/eby/bi_lib_eve 

/default_host/sap/bc/bsp/eby/fr_lib 

/default_host/sap/bc/ui5_ui5/eby/bi_eve_config 

/default_host/sap/bc/ui5_ui5/eby/bi_fiori  

/default_host/sap/bc/ui5_ui5/eby/bi_lib_eve 

/default_host/sap/bc/ui5_ui5/eby/fr_lib 

/default_host/sap/opu/odata/eby/bi_analytics_data_srv 

/default_host/sap/opu/odata/eby/bi_eve_configuration_srv 

/default_host/sap/opu/odata/eby/bi_eve_dynamic_tile_srv 

/default_host/sap/opu/odata/eby/bi_pfa_persistence_srv 

3. In transaction SPRO, go to SAP NetWeaver > UI Technologies > SAP Fiori > Initial Setup > Initial 
Launchpad Configuration and select Service Maintenance of SAP Gateway. 

4. Assign a system alias for the following services.  

• /EBY/BI_ANALYTICS_DATA_SRV 

• /EBY/BI_EVE_CONFIGURATION_SRV 

• /EBY/BI_EVE_DYNAMIC_TILE_SRV 

• /EBY/BI_PFA_PERSISTENCE_SRV 
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To assign a system alias, complete the following steps: 

a. Click on the service, then click the Add System Alias button. 

b. Add a new entry. 

c. In the Service Doc. Identifier field, type the service ID.   

d. Set SAP System Alias to LOCAL and select Default System. 

 

Define KPI groups 
Before activating the tiles in the Fiori Launchpad, you must add the corresponding entry in the SAP 
backend. 

1. Go to transaction /EBY/BI. 

2. Select --- Maintain at Backend --- > Define KPI groups. 

3. Add a new entry. 

4. Enter the details for the group. 

 

 Activate tiles 

Launchpad tiles are created in catalogs in the SAP Launchpad designer. Catalogs are collections of tiles 
that have similar technical or business functionality (similar to the development packages in ABAP). You 
can then add the tiles to groups. Groups are collections of tiles for specific end users and can contain tiles 
from different catalogs. You can grant independent access to catalogs and groups 
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Create a catalog 

To create a catalog, complete the following steps. 

1. In the standard Launchpad configuration, under the Catalogs section, in the footer, click the button to 
display the Create Catalog dialog box.  

2. Enter a title and ID for the new catalog and click Save.  

The new catalog is created.  

Note: The title and ID should follow the customer-specific naming convention.  

Example: zcustomer_cat1 

 

Add the Process Analytics App to the catalog 

Create the target mapping  

To create the target mapping, complete the following steps. 

1. Click the Target Mapping icon, then in the footer, click Create Target. 
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2. In the form that opens, enter the following information: 

• Semantic Object: FioriApplication 

• Action: toPADashboard 

• Application Type: SAPUI5 Fiori App 

• Title: Process Analytics Dashboard 

• URL: /sap/bc/ui5_ui5/eby/BI_FIORI/ 

• ID: eby.eve.dashboard 

• Device Type: (x) Desktop ( ) Tablet ( ) Phone 

3. Save your changes and go back. 

Create a tile 

To create a tile within the new catalog, complete the following steps. 

1. Click the Tiles icon, then in the footer, click Create Tile. 
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2. Click App Launcher – Dynamic. 

 

 

3. In the form that opens, enter the following information: 

• Title: PA Dashboard (or any custom text) 

• Icon: sap-icon: //Fiori2/F0194 ( as example) 

• Service Url: /sap/opu/odata/eby/bi_eve_dynamic_tile_srv/TileData('AP') 

• Semantic Object: FioriApplication 

• Action: toPADashboard ( = value from field Action from Target Mapping) 

• Parameters: sap-apf-configuration-id=AP.AP 

Note: The substrings in the fields Service Url and Parameters (here: AP) must exactly match the 
entry in /EBY/BI > Define KPI Groups. 

 

4. Save your changes. 

With this approach you can group later different KPIs to different tiles. 
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Add the Process Analytics Configure App to the catalog 

Select the previously created catalog or create a new catalog according to instructions above if you want 
to separate access to the Configuration App from the Process Analytics App. 

Create the target mapping  

To create the target mapping, complete the following steps. 

1. Click the Target Mapping icon, then in the footer, click Create Target. 

 

2. In the form that opens, enter the following information: 

• Semantic Object: FioriApplication 

• Action: toPAConfig 

• Application Type: SAPUI5 Fiori App 

• Title: Dashboard Configuration 

• URL: /sap/bc/ui5_ui5/eby/bi_eve_config 

• ID:  eby.eve.flowConfig 

• Device Type: (x) Desktop ( ) Tablet ( )Phone 

3. Save your changes. 
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Create a tile 

1. Click the Tiles icon, then in the footer, click Create Tile. 

 

 

2. Click App Launcher – Static. 

 

 

3. In the form that opens, enter the following information: 

• Title: Dashboard: Configuration 

• Icon: sap-icon: //add-equipment  ( as example) 

• Semantic Object: FioriApplication 

• Action: toPAConfig (the Action from the Target Mapping) 

Add the catalog to the role in SAP 

See Authorizations and roles for information on adding the catalog to the role in SAP. 
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Configure Process Analytics 

Configuration in SAP 

Define configuration users 

To define users who are able to customize data flows, complete the following steps. 

1. Go to transaction./EBY/BI. 

2. Select --- Maintain at Backend --- > Define Configuration Users. 

3. Click Display/Change  and add a new entry. 

4. Enter the user ID of each user who should have authority to create data flows. 

5. Click Save . 

Define KPI Groups 

To group different dashboard tiles in different KPI groups, complete the following steps. 

1. Go to transaction /EBY/BI. 

2. Select --- Maintain at Backend --- > Define KPI groups. 

3. Add a new entry. 

4. Enter the details for the group. 

 

Separate tiles can be created in the Fiori Launchpad Designer which are differentiated by KPI groups that 
are created in this activity. 

Dashboard tiles then are included in a KPI group, essentially in different dashboard tiles. 

Configuration in FIORI Launchpad 

Define the flow 

To create a new data flow, complete the following steps. 

1. From the Fiori Launchpad, open the PA Configuration App and click Add . 
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2. Enter an ID and a description for the new flow, then click Submit. 

 

The new data flow is now visible in the overview screen of the Configuration App. 

 

3. Click the button to activate your flow . 

You can also create a data flow by clicking the Copy icon  in the row of an existing data flow. 

To delete a data flow, click the Delete icon  in the row of an existing data flow. 

Create characteristics 

A characteristic represents an additional level of detail for the KPI.  

For example, the KPI “Number of unprocessed MM documents” could have additional characteristics like 
“Company Code” and “Document Processor”. When a user opens the KPI, additional navigation is 
possible to view the KPI metric in respect to company code or document processor. 

To create a characteristic, complete the following steps. 

1. Click on the data flow. 

2. Click Menu , then click Edit > Characteristics. 
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3. Click the arrow  next to a characteristic to edit it. 

 

Bin supplement 

Bin supplement is a special characteristic that is used when you want to split all numerical values in 
ranges. 

For example, you have the KPI “Amount for documents in process”, where you want to split invoices into 
3 sections: “Invoices with insignificant amount”, “Invoices with regular amount”, and “Invoices with high 
amount”. 
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Available characteristics 

The following Characteristics are currently available 

Characteristic Description Data Element Characteristic Class Bin 
Supp  

Date 

AGING_UNTIL_POS
TING 

Processing 
time ranges 

/EBY/BI_NUMERICAL_BIN /EBY/CL_EVE_NUMERICAL_
BIN_ATTR 

X  

AUGDT Clearing date AUGDT /EBY/CL_EVE_DATE_ATTR   

CH_USER Document 
processor 

/COCKPIT/DCH_USER /EBY/CL_EVE_USER_ATTR   

COMP_CODE Company 
Code 

BUKRS /EBY/CL_EVE_COMPCODE_
ATTR 

  

DATE_DAY Date /EBY/BI_DATE /EBY/CL_EVE_DATE_ATTR  X 

FI_MM_FLG FI/MM Flag /COCKPIT/DFI_MM_FLG /EBY/CL_EVE_FIMMFLAG_A
TTR 
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Characteristic Description Data Element Characteristic Class Bin 
Supp  

Date 

STATUS Status /COCKPIT/DPROCESS_STA
TUS 

/EBY/CL_EVE_AP_STATUS_
ATTR 

  

SYSTEM_ID System ID RFCDEST /EBY/CL_EVE_SYSTEM_ID_
ATTR 

  

VENDOR_NO Vendor LIFNR /EBY/CL_EVE_VENDOR_ATT
R 

  

For Binary Supplement characteristics, you must define value ranges, for example: 

Characteristics Description Range Description From To   

AGING_UNTIL_POSTING Processing 
time ranges 

     

  Short (less than 4 
days) 

0,000 4,000   

  Medium (between 4 
and 7 days) 

4,000 7,000   

  Long (more than 7 
days) 

7,000 9999,999   

Create a data source node 

The Data Source Node is the data entry point of the flow. 

To assign a data source to the flow, complete the following steps. 

1. Click Menu , then click Edit > Create Source Node. 

2. Select the existing source (for example, AP Header source), or click Add new to create a new source 
node. 
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The details of the new source appear on the right side of the detail screen. 

 

3. Click Edit to enter values. 

  

4. In the ABAP Class list, select AP document header source. 

 

5. Select the Active check box for each characteristic or key figure you later want to use in your 
evaluations.  

For currency key figures, assign a value in the Currency column. 
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For your own source nodes, copy the class /EBY/CL_EVE_SOURCE_AP_HEADER into the 
customer name space in the SAP backend. 

Data sources can be used in multiple flows, so any source field that is already used in a different flow 
cannot be removed in this flow. It appears with a ‘lock’ icon and is selected automatically. Only source 
fields that are not yet used in a different flow can be added here by selecting the Active check box. 

To remove any source field from the source node, check the usage in different flows first for this field 
and delete the usage there before removing the source field completely from the flow. 

6. Click Save modifications . 

Create a filter 

1. Select the new data source node and click Create child node, then click Filter. 

 

2. Select an existing filter from the list or click Add new to create a new filter. 
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The details of the filter appear on the right side of the detail screen. 

3. Click Edit to enter values. 

: 

a. Enter a title. 

b. Select Generic Filter for simple evaluations. 

c. Click Characteristic or Keyfigure. 

d. Select which characteristic you want to evaluate. 

e. Select respective comparison operator. 

f. Select the value to filter. 
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4. Click Save modifications . 

The new filter appears in the overview on the left side. 

 

With the current filter setup, only rejected documents are evaluated. Normally, you would use the filter the 
other way round, that is, exclude documents with Status = 13 from the flow. This can be customized just 
after adding the next Staging step to the flow. 

You can add now more filters or create a supplement before creating an aggregate. 
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Define a supplement 

A supplement adds a new column to your data structure and fills it with data. This column can have either 
the “Characteristic” or “Keyfigure” type. You must provide a class which will define the supplement logic 
(except for a “Bin Supplement Characteristic”). 

To define a supplement, complete the following steps. 

1. In the data flow overview, select the new filter. 

 

2. Click Create child node and select Supplement. 
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3. Select one of the existing values. 

 

4. Click Save modifications . 

5. You can now set the previously created filter as a ‘negative filter’. In the data flow overview, click on 

the icon  and select Set to negative filter input. 
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Define an aggregate 

An aggregate is a table whose columns are added from “Characteristic” and “Keyfigure” fields. For 
example, if you select the characteristics “Vendor” and “Processor” and the key figure “Document 
amount”, the columns “Vendor”, “Processor” and “Document amount” will be available. 

The table lines are filled with the data found during extraction. 

We recommend using at least one and a maximum of two characteristics per aggregate or KPI. A larger 
number of characteristic results in to extensive memory usage. 

To define an aggregate, complete the following steps. 

1. In the data flow overview, select the new supplement. 

2. Click Create child node and select Aggregate. 

 

3. Click Edit to enter values. 

 

4. Enter a title (for example, “Number of invoices in process”) and select Store in database. 
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5. Click the Add button and select up to two characteristics that you want to evaluate. 

 

The aggregated data can now be presented as a number, for which the characteristics supplement 
DOC_COUNTER is used. It will later be presented as an integer value and not with a unit or currency 
field. 

 

6. Click Save modifications . 

You have now added an aggregate:  

• That ignores documents with Status (13)   /  Filter  

• Adds a supplement field Days since Creation /  Supplement  

The aggregate can be displayed as document counter. 

 

The presentation of aggregates can now be customized in a dashboard Tile. However, it is often more 
required to display a relation between two aggregates as a key figure, for example: 

KPI Ratio of MM Invoices = Number of MM invoices in process / Number of invoices in process 
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You therefore need to create an additional filter for MM documents and a new aggregate on the filtered 
value. 

1. Select the supplement Days since Creation and add another filter: 

 

 

The filter appears in the correct hierarchical order and you can see that the aggregate Number of 
Invoices in process does not use the Filter on MM filter. 

 

2. Add a similar aggregate, as described for the Number of Invoices in process aggregate. 
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Use a different title, but the same characteristics and key figures. 

 

After creating aggregates, you can now build a KPI from two aggregates. 

Define a KPI 

A KPI is a table with a flexible set of “Characteristic” columns and one obligatory “Keyfigure” column. 

The KPI calculation is executed based on two parent aggregate objects. 

A KPI can only use the characteristics that are used in both parent aggregate objects. 

To define a KPI, complete the following steps. 

1. Select one of the previously created aggregates and create a key performance indicator (KPI). 



 

 

Kofax Process Analytics for use with SAP Fiori® Installation and Configuration Guide 

37 

 

The ‘Ratio of displayed documents’ will be calculated based on the aggregates Number of MM 
documents and Number of invoices in process. 

 

 

2. Select Decimal as the type and Unit Percentage (P1) to display the ratio correctly in the subsequent 
Dashboard Tile. 
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Assign a dashboard tile 

The dashboard tile defines how the KPI or aggregate is displayed and in which group it is displayed. 

Current display types are: 

• Just text 

• Number 

• Chart 

• Chart and Number 

If no dashboard tile is assigned to the KPI/aggregate, the KPI/aggregate is not be displayed. 

To assign a dashboard tile, complete the following steps. 

1. Select the previously created KPI and create a dashboard tile. 

 

 

2. Enter a threshold value to indicate how the KPIs are displayed. 
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The dashboard tile is included in the AP Group (see Define KPI Groups).  

The KPI will be displayed as number. 

It is possible to define ranges for the display of the KPI. 

In the example above, example an MM Invoice rate of more than 60% will be displayed as a positive 
value. 

Manual activities after each configuration change 

To avoid caching issues after each configuration change, complete the following steps. 

• Go to transaction /IWBEP/CACHE_CLEANUP to clear the cache on the Backend and Gateway 
(oData cache clearing).  

• Go to transaction SHMM to delete all entries that start with /eby/* to initialize Shared memories. 

• Empty the browser cache. 

Transport the configuration 

To transport your configuration, complete the following steps. 

1. Go to transaction /EBY/BI. 

2. Select --- Maintain at Backend --- > --- Generated by Fiori Application --- > Define Data Flows. 

3. In change mode, select the flow to be transported and in the Table View menu, click Transport. 
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4. Include the selected entry into a customizing request and click Save . 

All related table entries from the related maintenance objects are also saved in the same transport 
request. 
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Set up Process Analytics data load 
The Process Analytics data load can be performed both manually and automatically. 

Manual data load 

1. Go to transaction /EBY/EVE_PROCESS. 

2. Click  Start processing…. 

• To reload the data completely, select Full load. 

• To load only recent data changes, select Reconciliation load. 

• If you have changed KPI data, you need to perform a full data refresh. First click Reset and Lock 

Processing , then click Start processing and select Full load. 

 

Automatic data load 

For automatic data load, schedule a job in transaction SM36. 

Note: This will load recently changed data only. If you changed KPI data, remember to perform the steps 
listed Manual data load. 

1. Go to transaction SM36. 

2. Enter a name for your new job. 
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3. Click Step . 

4. Click ABAP Program enter the program name /EBY/BI_EVE_BATCH_PROCESSING. 
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5. Click Save  and return to the Define Background Job view. 

6. Click  Start condition. 

 

7. In the Start Time dialog box, select the Periodic Job check box. 
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8. Click Period value and then click Other period. 

 

9. Enter an interval in hour or minutes and click Save . 

10. In the Period values dialog box, click Save . 

11. In the Date/Time group, enter the scheduled start date and time, then click Save . 
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12. In the Define Background Job view, click Save . 
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Troubleshooting 

Introduction 

This section aims at troubleshooting issues that may occur while configuring the Process Director 
Accounts Payable for use with SAP Fiori® application, which uses the /EBY/FRAP_WC service. For other 
applications, the names should be correspondingly modified. 

Basic system settings 

Parameter: login/create_sso2_ticket 

To get rid of the error message encountered in the gateway client on trying to run the oData service, 
modify the login/create_sso2_ticket system parameter. 

Selection of default profile for virus scan  

1. Based on the assumption that there are no other requirements for the default profile for the virus 
scan, run the SM30 transaction for the /IWFND/C_CONFIG table. 

 

2. Modify the value for the GATEWAY_VIRUSCAN_PROFILE parameter to -.  

If this parameter does not exist, add it first in the /IWFND/C_COF_PAR table. 
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System alias  

In the IMG, go to Define SAP System Alias. 

 

One-system configuration (backend and frontend in one system) 

Create the LOCAL system alias. 

 

Two-system configuration (backend and frontend in separate systems) 

In this scenario, the alias works as a  proxy to the remote system. 

1. The user needs to have authorization for the S_RFCACL object, in both the systems. 
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2. Create a trusted RFC connection. 

 

In the Logon and Security tab, make sure to leave the Language field blank. 

 

3. Create the alias. 

In the System ID field, provide the SAP system name for the backend system. 
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OData service configuration 

1. In the IMG, go to Service Maintenance of SAP Gateway. 
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2. Verify if the /EBY/FRAP_WC service has already been preset. 

• If it has a green status and in the ICF Nodes section, the Session Time-out Soft State value 
equals 00:05:00, and also the system alias has been defined, the service is configured correctly. 

 

Note: This timeout defines the time for which a document remains locked in the application. For a 
longer session lock period, consider modifying this parameter. 

• If the ICF Node status is yellow, the only thing you need to do is activate it and proceed to the 
next step of creating the service. 

 

• If the service does not exist, or exists, but the status in the ICF Nodes section is blank or the 
Session Time-out Soft State value equals 00:00:00, remove the alias and ICF Node first to 
remove the service. 

Create the service 

1. Click Add Service. 

 

2. In the Filter section, populate the values, with /EBY/FRAP_WC as the Technical Service Name and 
FRAP_WC as the External Service Name. 
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3. Press Enter. In the Select Backend Services section, select the line and click Add Selected 
Services. 

 

4. Correct the names suggested by the system (starting with Z*), to names starting with /EBY/*.  
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5. Provide the Package Assignment as /EBY/FRAP. 

 

6. Go back to the service list. 

Assign the alias 

1. Click Add System Alias. 
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2. Use the search help to select the /EBY/FRAP_WC_0001 service. 

 

3. Assign the LOCAL or remote system alias, depending on if you have one- or two-system 
configuration. 

 

Note: TST is an example of an additional remote system. Depending on the requirements of your 
system landscape, you can use any suitable name for the remote system alias. 
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4. Go back to the service list. 
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ICF Node 

The Process Director Accounts Payable for use with SAP Fiori(r) application uses two ICF Nodes: 

• Odata 

• Application services.  

The OData service should either already exist and have been activated, or should be created (recreated) 
for the newly added /EBY/FRAP_WC service. 

 

If this ICF Node has a blank status or the Session Time-out Soft State value is set to 00:00:00, the node 
needs to be created, or deleted and recreated. 

1. Run the SICF transaction, click the Execute button, and then go to the following path. 
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2. Select the eby position and click Create Host/Service. 

3. Confirm the popup and in the Name of Service Element to Be Created field, enter frap_wc. 

4. Click OK. 

5. Provide a description and in the Session Timeout field, enter the required time interval (for example, 
00:05:00). 

 

6. Switch to the Handler List tab. 
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7. Add /IWFND/CL_SODATA_HTTP_HANDLER to the Handler List. 
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8. Go back to the service list and activate the service. 
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Activate the soft state in the services list 

Verify if the soft state of the /EBY/FRAP_WC service is active. If not, click Soft State to activate it. 

 

SAP Internet Communication Framework 

The SICF (SAP Internet Communication Framework) standard transaction code is used to maintain the 
services for HTTP communication in the SAP system, using the Internet Communication Manager (ICM) 
and the Internet Communication Framework (ICF). 

Application service activation 

This applies only to the one-system configuration or to the frontend system in the two-system 
configuration. 

For the two-system configuration, the OData service exists in both the backend and frontend systems. 
The application service exists only in the frontend system. 

You have to verify if the application service is active. If it is not, you need to activate it. 

Activate the service element tree nodes 

To activate the service element tree node, complete the following steps. 

1. Run the SICF transaction. 

2. In the Service Name field, enter frap_wc and click the Execute button. 

3. Right-click the frap_wc tree nodes and select Activate Service. 
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4. Run the SICF transaction again. 

5. In the Service Name field, enter fr_lib and click the Execute button. 

6. Now, right-click the fr_lib tree nodes and select Activate Service. 

 

Note: Both frap_wc and fr_lib need to be activated, regardless of the sequence you follow. 

If the customer’s SAP runtime environment is set up correctly, you can now start the application. 

7. Right-click any fr_lib entry and select Test Service. 

8. Activate it. 

 

Deactivate the parallelization of batch requests  

If the parallelization of batch requests is active, soft state does not work. It can be activated globally, and 
deactivated for each service. 

To deactivate it for a service, complete the following steps. 
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1. In the service maintenance (/IWFND/MAINT_SERVICE) transaction, click Service Implementation. 

 

2. Click Configuration. 

 

3. Deselect the Deactivate Parallelization of Batch Requests check box. 
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Activate and maintain services 

The OData service for the Process Director for use with SAP Fiori® application is a part of the transport 
and should be automatically activated in the customer system. To check this, complete the following 
steps. 

1. Go to the /IWFND/MAINT_SERVICE transaction.  

2. Select the /EBY/FRAP_WC technical service name. 

3. Activate the ICF Node for the Odata service. 

 

4. Click Call Browser. 

A browser window displays the metadata of the OData service, in the XML format. 

SAP Gateway troubleshooting 

In case of errors, it is still viable to use the ST22 transaction to check for them. However, this does not 
cover web-specific errors. Web-specific errors are logged in the /IWFND/ERROR_LOG (SAP Gateway 
Error Log) transaction. 

View model troubleshooting 

Although the first Environment field in the configuration of the view model settings is not mandatory and 
the system environment should be automatically used, if an error is encountered, ensure that this field is 
filled in. 

For more information about view model configuration, refer to the Process Director Configuration Guide. 
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